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Introduction 
 
 

 You will gain the most from this guide by first reviewing it. In addition, be 
sure to back up your data. 

 
Data integration between BillQuick® (by BQE Software) and MYOB® (by MYOB Technology Pty Limited) 
can make your time billing, accounting, and financial management tasks easier. Full-featured, BillQuick 
Time Billing and Project Management software helps you manage your company, whether your time, 
expense, billing and reporting needs are simple or you require complex billing, reporting and 
management capabilities. MYOB is a multi-user business management software package providing 
business solutions such as integrated payroll, inventory, multiple currency transactions, profit and loss 
analysis and other financial tasks. Integrated, BillQuick and MYOB deliver a virtual program that ensures 
data accuracy, eliminates time-consuming duplicate manual entry, enhances flexibility, and increases 
control over your bottom line. 
 

The goal of the BillQuickMYOB Integration Guide is to help new BillQuick users effectively integrate 
data between BillQuick and MYOB. BillQuick controls the integration, enabling you to choose what data 
flows between the programs, and much more. 
 
 

How to Use This Guide 
 
Integration means data from one program transfers to another. This sharing offers many benefits. You 
control what data transfers to and from BillQuick using synchronization settings. Your preferences tell 
BillQuick exactly how you want it to interact with MYOB. BillQuick automatically creates smart 
connections using your settings and its built-in intelligence. 
 
We encourage you to review the How Integration Works section. Written for users with a non-technical 
background, it explains the integration rules built into BillQuick. Understanding what types of data may 
be shared, and which rules apply during synchronization, helps you visualize what is happening behind 
the scenes.  
 
In Initial Integration section, you learn how to integrate data with the other program. Instructions guide 
you through the initial integration process according to your scenario-new BillQuick and existing MYOB 
user. 
 
After integration, data is to be checked to make sure everything is synced accurately. Quick Check 
section provides specific guidance on this aspect. The section on Day-to-Day Integration Settings 
provides suggestions for fine-tuning synchronization settings for normal, day-to-day processing.  
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Software Editions Supported 
 
All BillQuick editions – Basic (Microsoft Access database), Pro (Microsoft Access and SQL Express 
database) and BillQuick Enterprise (Microsoft Access, SQL Express and Microsoft SQL Server database) – 
integrate with the following MYOB editions: 
 

 MYOB Premier Australian Edition (v9 to v19) 

 MYOB Premier Enterprise (v9 to v19) 

 MYOB Accounting (v15 to v19) 

 MYOB Accounting Plus (v15 to v19) 
 

 Due to technical reasons, we recommend existing users not to upgrade 
their MYOB software to AccountRight 2011/2012 (new versions of MYOB) for 
your BillQuick-MYOB integration to work smoothly. Users with AccountRight 
2011/2012 will need to enter their invoices manually or perhaps use text-file 
based transfers. Please contact the BQE Australian Office (1-300-245-566) 
for status updates. 
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How Integration Works 
 
 
Whether you have a technical background or not, it is helpful to understand the basics of 

BillQuickMYOB integration. This can help you visualize what is happening behind the scenes as 
BillQuick manages the transfer of data to and from MYOB. 
 
For data integration, you need to install the ODBC Driver to connect successfully to the MYOB program. 
BillQuick must be allowed to access MYOB for the intelligent, automatic integration to be successful. You 
can send BillQuick activities, expenses, employees, vendors, clients, projects, time entries, invoices, and 
payments to MYOB, using the appropriate option from the menu. You can get activities, expense items, 
employees, suppliers, customers, jobs, activity slips, invoices, and payments from MYOB into BillQuick.  
 
The table below shows the direction in which data can potentially flow between BillQuick and MYOB. 
Whether it flows in one direction or the other depends on your choices in the BillQuick-MYOB Sync 
Settings screen (discussed in Initial Integration section). Each record common to BillQuick and MYOB 
shares a unique Link ID that identifies it as related. This does not mean data in both database is exactly 
the same; only that they share common data. For example, BillQuick Project records contain data that 
MYOB Job records do not and vice versa. What is important for integration is that the two programs 
share key data.  
 

BillQuick  
Table Name 

Dataflow MYOB  
Table Name 

Activity Codes*  Activities List 

Expense Codes*  Items Bought** 

Employee*  Cards-Employee 

Vendor*  Cards-Supplier 

Client*  Cards-Customer 

Project*  Job 

Time Entry  Activity Slips 

Purchase Orders  Purchase Orders 

Chart of Accounts  Chart of Accounts 

Invoices  Invoices  

Payments  Payments 

*The screen name may be different based on your profession or industry, or if you customized them using 
BillQuick Custom Labels feature. 

** Items that are marked as ‘I sell this’ in MYOB, are marked as Products in BillQuick. 

 

 To review detailed, field-by-field mapping of records between MYOB and 

BillQuick, see BillQuick Help, BillQuickMYOB Integration, Table and Field 
Mapping. 

 
As you can see above, integration between BillQuick and MYOB is very comprehensive. Not only are 
invoices sent to MYOB to post revenue and receivables, the virtual database for the two programs 
includes clients, projects/jobs, employees, vendors, activity codes, and so on. 
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Bottom Line: The major benefit is that you do not have to re-enter BillQuick data into MYOB. BillQuick 
manages the process, using your synchronization settings. 
 
 

Integration Rules 
 
Depending on what information is given in BillQuick, the data transfer fills the fields in MYOB Card File 

accordingly. To ensure accuracy and completeness of data transfer, BillQuickMYOB integration 
follows a set of rules. These are: 
 

1. Company Start Date: MYOB accepts the transfer of transactions only if their dates are 
after the start date of the MYOB Company. Thus, when you are integrating with MYOB 
for the first time, and manually entering invoices or payments from a prior fiscal year, 
be sure to check the start date for the MYOB Company to prevent loss of data.  

2. Synchronization Order:  When you send or get data on-demand from BillQuick or MYOB 
(via Send or Get menus), BillQuick ensures that corresponding required data is also sent 
(for example if Projects are sent before Clients, Clients associated with the Project are 
also sent). To help speed up the synchronization process, please follow the order of the 
submenus. For example, you should sync Clients before Projects and Invoices before 
Payments.  

3. MYOBLinkID: BillQuick automatically creates an internal MYOBLinkID and adds it to the 
database. Used for internal processing, the special ID ensures accurate and complete 
transfer of data. 

4. Placeholder Data: Because MYOB does not require the same data fields and may not 
track the same data as BillQuick, BillQuick inserts ‘FromBQ-MYOBSync’ (for example) as 
a placeholder value when it encounters these situations. As part of the data checking 
procedure, you would change ‘FromBQ-MYOBSync’ to whatever value you desire for the 
field. For example, if the First and Last Name fields on MYOB’s Vendor screen are blank, 
BillQuick inserts ‘FromBQ-MYOBSync’ into its First and Last Name fields during 
synchronization.  

5. Employee Transfer: When an employee with ID ‘supervisor’ in MYOB is transferred to 
BillQuick, by default ‘From Supervisor-MYOB Sync’ is used as the employee name. 

6. Rates: When transferring employee data from MYOB, BillQuick checks to see if the 
optional bill and cost rate fields in MYOB contain values. If they do, BillQuick transfers 
them to an employee’s profile. If the fields are blank, BillQuick inserts $0 in the Bill Rate 
and Cost Rate fields in the employee’s profile. 

7. Activities: Prior to sending activities from BillQuick to MYOB, if you have not specified 
the MYOB income account and the tax code in Sync Settings, billable activities transfer 
as non-chargeable activities to MYOB. Chargeable and non-chargeable fields can’t be 
updated after data is sent to MYOB. 

8. Vendors: When transferring data from BillQuick to MYOB, if we have vendor’s first 
name and last name specified but not the company, then the mapping is as follows: 

First name - First Name 

Last name - Last Name  
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But if we have the company name and do not transfer first name and last name of the 
vendor, then the mapping is as follows 

Company – Name 
Designation gets set according to the fields transferred. Same is true for client.   

9. Project:  
 Maximum length for Project ID and Activity ID in MYOB is 15 characters. If you have 

integrated with MYOB, you will be warned if you create new projects and activities with 
more than 15 characters.  

 Because BillQuick requires assignment of a Project Manager and there is no 
corresponding field in MYOB, BillQuick creates a new employee record with 
placeholder values, ‘FromBQ-MYOBSync’, as part of the above scenario. 

 When projects in BillQuick are transferred to MYOB, the projects with the status 
Completed, Hold, Cancelled and Inactive, are transferred as inactive. Projects 
with status other than these are transferred as ‘active’. 

10. Time Entry: 

 A time record can be transferred from BillQuick to MYOB only once. 

 Both negative time entries and zero hour time entries can be transferred to 
MYOB. 

 You can choose whether to map BillQuick time entries to MYOB Activity Slips 
(default) or Timesheets. 

11. Expense Entry: An expense recorded in BillQuick Expense Log transfers to MYOB as an 
expense. During the transfer, the following rules are applied:  

 An expense recorded in MYOB transfers to BillQuick only if it is marked ‘I buy 
this item’. 

 When transferring expense codes from MYOB to BillQuick, the items are marked 
as products if marked as ‘I sell this item.’ 

 When transferring expenses, the average cost item is transferred according to 
the item cost in BillQuick. 

 When transferring expenses from MYOB to BillQuick, the markup percentage 
per item is calculated using MYOB’s base selling price and average cost. 

12. MYOB Invoice: BillQuick determines whether to transfer an invoice from MYOB after 
checking for associated projects, clients, and invoice items. When transferring invoices 
from MYOB to BillQuick, several scenarios can arise.  

 Invoice for Client but No Job Record: When a MYOB invoice has no specified job, 
BillQuick automatically creates a new project for the invoice. The Project ID is 
based on the Client ID on the Invoice.  

 Invoice for Project without Client: When an MYOB invoice for a project does not 
have a client associated with it, BillQuick automatically creates a new project 
and a new client before saving the invoice. The Client ID is based on the MYOB 
Project ID on the invoice. 

 Multiple Items for Multiple Projects: When transferring an invoice from MYOB 
(having multiple invoice items for multiple projects, but with same specific 
client), BillQuick creates a joint invoice for all invoice items, associating it with 
that specific client. In this case, the Invoice Client ID becomes the Project Client 
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ID in BillQuick. However, if the specific clients associated with the projects on 
the invoice are different, then BillQuick does not transfer the invoice. 

 Invoice for Project with Client associated with a different client: When 
transferring an invoice from MYOB, with an associated client for a project 
having its own specific client, BillQuick associates that invoice with the specific 
client of the project. In this case, the Invoice Client ID will be the Project Client 
ID. 

 Transferred as Manual Invoices: When invoices are transferred from MYOB to 
BillQuick (without time and expense entries), they are received as manual 
invoices. With MYOB Accounting Plus and Premier editions, time and expense 
data also transfers. 

 Project-level accounts are used for invoices transferred into BillQuick via data 
integration. 

13. BillQuick Invoice: When invoices transfer from BillQuick to MYOB, the following rules 
are applied:  

 Accounts: The items are sent to service amount, expense amount, and discount. 

 Time and Expense Details: Invoices are transferred from BillQuick to MYOB and 
vice versa, with or without time and expense details (depending upon your 
MYOB edition). 

 Discount: Discounts are applied prior to application of tax to the items. 

 Draft Invoices: Draft invoices in BillQuick are not sent to MYOB.  

 Taxes: For invoices created in BillQuick with Main Service Tax (MST) and Main 
Expense Tax (MET) attached to them, the values of Service Amount, Expense 
Amount and Discount are sent to the respective fields in MYOB  (value prior to 
taxes). To each item, GST is assigned as the tax code, and the MST and MET 
amount is assigned as the tax amount for Service Amount and Expense Amount. 
GST includes item taxes when transferring invoices. 

 Joint Invoices: If a joint invoice is transferred from BillQuick to MYOB, it is 
converted into two invoices in MYOB (with the respective projects and amounts 
specified). 

 Line Items: When sending invoices from BillQuick, full details are sent over to 
MYOB but the summary line items with zero value are skipped. 

14. Retainer: When transferring retainer information from BillQuick to MYOB, both client 
and project retainer are transferred as Client Credit in MYOB. When getting the retainer 
value from MYOB to BillQuick, the value is stored as Client Retainer in BillQuick.  

15. Payment: Payments recorded in MYOB transfer to BillQuick along with related invoice 
data. 

 If a payment does not have associated invoice data (for example, invoice 
number), it is recorded as a Client Retainer in BillQuick. Similarly, when invoices 
are transferred from BillQuick, the applied payments will be transferred along 
with the invoice data. 

 If the Invoice Client ID in BillQuick does not match with the actual Payment 
Client ID in MYOB, the payment will not be transferred to BillQuick. 

 Project-level accounts are used for payments transferred into BillQuick via data 
integration. 
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Synchronization Settings 
 
In BillQuick, you can specify data transfer rules and settings in the BillQuick-MYOB Sync Settings screen. 
These settings apply company-wide and are used as defaults when you choose to sync data between 
BillQuick and MYOB.  
 
Using the BillQuick-MYOB Sync Settings screen, you can specify the following settings: 
 

 General 
 Send Settings 
 Get Settings 
 Account Assignment 

 

General Settings 
 
The General tab allows allow you to specify general settings for data transfer from BillQuick to MYOB 
database, such as the MYOB data file, and so on. For description of each field on this tab, see the 
BillQuick Help. 
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Send Settings 
 
Send settings allow you to set rules for data transfer from BillQuick to MYOB database. You can also 
restrict the data sent from BillQuick to MYOB and specify filters. 
 

 
 

 The send options change depending upon the module selected from the 
list on the left of the screen.  

  
BillQuick provides some options for sending BillQuick data to MYOB. For description of each field on this 
tab, see the BillQuick Help. 
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Get Settings 
 
Get Settings allow you to set rules for data transfer from MYOB to BillQuick database. You can restrict 
the data sent from MYOB to BillQuick and specify filters. 
 

 
 

 The Get options change depending upon the module selected from the list 
on the left of the screen.  

  
BillQuick provides some options for getting MYOB data to BillQuick. For description of each field on this 
tab, see the BillQuick Help. 
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MYOB Accounts 
 
A key step in the integration process is to assign general ledger (G/L) accounts to BillQuick activity codes, 
expense codes and other invoice items. In BillQuick, activity and expense accounts are not required, 
except for the purpose of data integration or accounts payable but MYOB requires G/L accounts for all 
items and transaction. 
 
For companies that integrate BillQuick with MYOB, they need to specify default General Ledger accounts 
for activities, expenses, invoice items, and payments in BillQuick (prior to syncing). Your MYOB company 
file contains an accounts list, which is used for organizing the accounting entries of your business. When 
you create the MYOB company file, you have the option of importing an accounts list, building a new 
one or using the preset accounts lists provided. The Accounts List screen contains eight types of 
accounts: Asset, Liability, Equity, Income, Cost of Sales, Expense, Other Income, and Other Expense. 
Different income accounts are created for each category of revenue that is being tracked (for example, 
retail income, service income, interest income, and so on). For accurate and effective data transfer, 
these accounts need to be specified for the BillQuick items being sent to MYOB. You can assign G/L 
accounts to various BillQuick items from the Global Settings, Project or other screens; else, do that on 
the Account Assignment tab of the BillQuick-MYOB Sync Settings screen prior to the synchronization. 
 
When BillQuick invoices are transferred to MYOB, by default it transfers the actual time and expense 
line items and posts them to their respective accounts. However, when invoice details are not 
transferred, BillQuick sends activity and expense items as single line items. Normally, the transactions 
debit or credit these accounts. You can assign G/L accounts to individual activity codes, expense codes 
and invoice items, or make these assignments at the project or project group level. 
 

 MYOB accounts are available for assignment in BillQuick only after a 
connection has been established between the two programs. 

 
If you integrate with MYOB and GET activity and expense items, the associated G/L accounts also carry 
to BillQuick. You can manually set up the Chart of Accounts in BillQuick or transfer it from MYOB 
through data synchronization. When an activity or expense is part of an invoice (associated time and 
expense entries are relieved with the invoice), and you sync that invoice with MYOB, the correct G/L 
account will be updated there. This tracks your company’s income and expenses in the accounting 
system. 
 

 It is preferable to create activity and expense (other charge) items in 
MYOB and have them transferred into BillQuick. This reduces the step of 
creating or assigning G/L accounts for them in BillQuick. 

 
Accounts for MYOB can be set up in two ways: 
 

1.  Integration menu: You can assign accounts to BillQuick invoice items via the BillQuick-MYOB 
Sync Settings screen. MYOB income and expense accounts are available for assignment after a 
connection between BillQuick and MYOB is established.  

2.  MYOB: If you integrate with MYOB and GET Activities and Items (expenses), the associated G/L 
accounts also transfer to BillQuick.  
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The BillQuick-MYOB Sync Settings screen allows you to specify the desired MYOB account to BillQuick 
items. You can make the following account assignments: 
 

 Default Accounts 
 Invoice Accounts 
 Project Accounts 
 Activity Accounts 
 Expense Accounts 

 

Default Accounts: While sending BillQuick data to MYOB, you must specify default accounts for billable 
activities, billable expenses, and payments. Besides these, you can also specify specific accounts to 
individual activity and expense items. For description of each field on this screen, see the BillQuick Help. 
To assign default accounts to BillQuick items sent to MYOB: 
 

1.  Open the BillQuick-MYOB Sync Settings screen from the Integration menu, MYOB.  
2.  Click the Account Assignment tab and select Default Accounts on the left.  

 

 
 

3.  Assign an Income Account and Tax Code for the billable activities that transfer from BillQuick to 
MYOB. Depending upon the tax settings specified here, different tax type, and rate applies to 
the activities. 



How Integration Works 

 

BillQuickMYOB Integration Guide 2015 v.2                                                                                                                               Page 12 

 If an income account and tax code is not specified, then BillQuick activity 
codes are transferred as non-chargeable activities to MYOB. 

   
4.  Assign an Income Account, Expense Account, and Tax Code for billable expenses that transfer 

from BillQuick to MYOB. Depending upon the tax settings specified here, different tax type, and 
rate applies to the expenses. 
 

5.  Next, assign a Deposit Account for payments that transfer from BillQuick to MYOB. You can 
select the Account Number or Name from the drop-down list. 
 

6.  When you have finished, click Save. 
 
Besides the default accounts, you can specify income and expense accounts for each BillQuick activity 
code (service item) and expense code (expense item). You can select a single item or multiple items 
from the grid and assign the desired account to it. If you leave it blank, BillQuick uses the default 
accounts specified above. 
 
To assign accounts to BillQuick activity and expense items: 

 
1.  Click on the Account Assignment tab and select Activity Accounts option on the left.  
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2. Select an Activity ID from the list and assign the desired Income Account and Expense Account 
for it from the drop-down list. 
 
The MYOB account chosen here is assigned to the selected activity (or activities) invoiced. By 
default, Other Income and Other Expenses accounts are selected but you can change them. 
 

3.  Similarly, select Expense Accounts option on the left and assign an Income Account and Expense 
Account to the desired expense items. 

4.  When you have finished, click Save. 
 
Invoice Accounts: Besides specifying default accounts for activity and expense items, you need to 
specify income and expense accounts for invoice items. These are the accounts into which the service, 
expense, tax, retainer and other amounts on BillQuick invoices transfer upon synchronization. 
 
To assign accounts to invoice items: 

 
1.  Open the BillQuick-MYOB Sync Settings screen from the Integration menu, MYOB. 
2.  Select the Account Assignment tab and click Invoice Accounts option. 
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3. Assign an Income Account and Expense Account from the drop-down list for the selected invoice 
items such as Service Amount, Tax Amount, Discount Amount, Retainer Amount, and so on. By 
default, Other Income or Expenses account is selected but you can choose any other account 
from the drop-down list. 
 

4.  Click Add to save the account assignments. 
 

5.  You are given the option of not sending time and expense details for various invoices 
transferred from BillQuick to MYOB. You can check any contract type (such as Hourly, 
Percentage, Cost Plus, and so on) or manual invoice for which you do not want to send time and 
expense details. 

 

 You can skip sending late fee invoices to MYOB by checking that option. 

  
6.  When you have finished, click Save. 

 
Project Accounts: When sending invoices to MYOB, BillQuick assigns accounts specified on the Invoice 
Accounts screen to the invoice items. You can override those accounts for projects by assigning G/L 
accounts to invoice items at the project or project group level. 
 
For the selected project or project group, each item on a BillQuick invoice like tax amount, discount and 
retainers can have a specific G/L account assigned to it. When you sync invoices with MYOB, the 
corresponding G/L account will be updated there. 
 
To assign accounts at the project level: 
 

1.  Open the BillQuick-MYOB Sync Settings screen from the Integration menu, MYOB.  
 

2.  On the Account Assignment tab, select Project Accounts option on the left. MYOB accounts are 
available only after you establish a connection between BillQuick and MYOB programs.  
 

3.  Select the desired Project or Project Group from the drop-down. 
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 If you assign accounts to the Project Group ‘ALL’, you no longer have to go 
back to Sync Settings screen every time you add a new project in BillQuick. 

 
4.  You can see a list of invoice items. Select an appropriate Income Account and Expense Account 

for each item from the drop-down lists. 
 

5.  Click Add to save the account assignments. 
 

6.  When you have finished, click Save and then Close. 
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Initial Integration 
 
 
BillQuick supports bidirectional integration with MYOB, meaning that you can exchange data between 
BillQuick and MYOB. Initial integration populates the BillQuick or MYOB company database with 
information from the other program. Your initial synchronization settings define what information and 
how much of it is shared with the other program. For example, you may decide to move MYOB data for 
only the last two years to BillQuick.  
 
Prior to initial integration, you must access the Sync Settings screen – which gives you extensive 
integration control. The tabbed screens can be used for initial integration as well as to define day-to-day 
integration processing rules. It is accessed from the Integration menu, MYOB.  
 

 During integration setup and synchronization procedures, both BillQuick and 
MYOB must be running.  

 
 

Registering and Connecting MYOB 
 
You may be an existing or a new user of MYOB. If a new user, you must have installed the MYOB 
program and ODBC Driver, purchased licenses, and created a new company file.  
 
Depending on the MYOB version you are using, you would need to download an ODBC driver that is 
supported by it.  
 

MYOB Version ODBC Driver 

Premier v9/Accounting v15 version 5.5 

Premier 10/Accounting 16 version 6.xx 

Premier 11/Accounting 17 version 7.xx 

Premier 12/Accounting 18 version 8.xx 

Premier 12.5/Accounting 18.5 version 9.xx 

 
If you are using MYOB Premier 11/Accounting 17 versions, you need to download ODBC 7.0.9 from our 
website. Newer MYOB versions do not require you to install the driver separately as it is in-built in the 
setup.  
 
You can download and install the MYOB ODBC AU edition from our website, if required. Else, you may 
do so from the MYOB website. 
 
MYOB does not want third party products to have open access to customer data files and hence you 
need to register your MYOB data file for ODBC access. Trusted programs can be granted Read/Write 
access by enabling the data file for third party access using the ODBC driver. 
 
To register your MYOB data file: 

http://www.bqe.com/Support_Download/ODBCv7.0.9_AU_Setup.zip
http://www.bqe.com/Support_Download/ODBCv7.0.9_AU_Setup.zip
http://www.billquick.com/support_download/ODBCv55_AU_Setup.zip
http://myob.com.au/
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1.   Go to: My.myob.com.au. 
2.  Under Register Product, click ODBC Activation. 

 

 
 

3.  On the screen, enter the 12-digit Serial Number and Activation Number of your product. Then 
click Submit. 

 

 
 

To integrate with BillQuick, you need to connect the BillQuick database with your MYOB company 
database. In MYOB, information about your company’s software license is held within the company 
database. To connect BillQuick to your company file you must update that license on the Company 
Information screen. In order to connect BillQuick to MYOB, please follow the steps below: 
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1. Open your MYOB company file and log in using ‘Administrator’ as the ID and Password. In case 
of a multi-user system, you should use the ‘Single-user Access’ option.  
 

 
 

2. After logging in, from the Setup menu, select Company Information. 
3. Review your company information. Click on the License button to enable your license (or 

purchase additional licenses by calling 1300 555 151). 
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4. Click Enable Online. MYOB contacts its licencing server and makes the necessary update in the 
local data file.  

 

 
 

If internet access is not available, you will need to call MYOB on the given number (1300 664 
585); enter the information requested into the telephone key pad; and then receive the 
Confirmation Code. 
 

5. Enter the Confirmation Code and click OK. 

 

After these steps have been completed, the file will be activated for Add-on Solution and 
BillQuick will be able to integrate with your MYOB company database. 
 
 

Scenario 1: Existing BillQuick-New MYOB User 
 
BillQuick users who are new to MYOB start by transferring information from BillQuick to a new MYOB 
database. After creating the MYOB file and setting synchronization preferences, you can initiate 
synchronization and check the transferred data.  
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Please follow the steps below to integrate BillQuick and MYOB. 
 
1.  Creating MYOB Database 
 
Before integrating with BillQuick, a new MYOB user must have downloaded and installed MYOB 
program. Next, you need to create a MYOB company and assign the Add-on Solution permissions (see 
Connecting MYOB above). 
 

1. When MYOB opens, create a new company using the New Company File Assistant.  
 

2. Enter company name, address and other details. 
 

 
 

3. Enter the required information and close. 
 
2.  Backing up Database 
 
For the first-time synchronization, it is important to back up your BillQuick database. Select BackUp 
Database from the Utilities menu. By default, BillQuick stores the backup copy in the same folder as the 
company database (for example, the standard installation folder x:\Program Files\BillQuick2015; x = 
drive letter). If you want the database copy to be saved in another location, select Global Settings-
Folders screen from the Settings menu and enter a new location.  
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3.  Specifying Synchronization Settings 
 
For BillQuick to know what data to transfer and other integration preferences, you need to define 
integration settings. Later, you can fine-tune the settings for day-to-day integration (see 5. Fine-Tune 
Synchronization Settings below).  
 

1. In BillQuick, look at the status line at the bottom. It displays the BillQuick database that is open. 
If it is not the one you want to integrate with the MYOB database, select File menu, Open 
Company, choose the correct company, and then continue to the next step. 

 
2. From the Integration menu, select MYOB, Sync Settings.  

 
3. Click the General tab. Under MYOB Settings, select the desired MYOB Data file (.myo) and MYOB 

Executable (Myobp.exe), which is available in the folder where you installed MYOB. This is 
required so that BillQuick can connect with the correct MYOB database for synchronization. 
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4. Select the right ODBC Driver String from the drop-down. It is pre-selected if the ODBC Driver is 
installed automatically with the MYOB setup. This file makes a connection between BillQuick 
and MYOB possible.  
 

5. Enter the User ID (default being Administrator) and Password (if any). Click Connect to load the 
company file and connect with the MYOB program. The location and path of the BillQuick 
Database integrating with MYOB is displayed at the bottom. 

 
6. Click Save to save your settings and establish the connection between the two programs. 

 
7. Next, move to the Send Settings tab. In order, select each Module and assign desired settings to 

it.  
 

8. You need to decide whether to send each type of BillQuick data to MYOB. If you want to restrict 
what data records transfer to MYOB, choose one or more filters. See Synchronization Settings 
for more information. 

 

 The Get Settings tab is not used because we are sending data from BillQuick to 
populate a new MYOB database. 

 
9. Click on the Account Assignment tab. Each BillQuick item has to be associated with a G/L 

account in MYOB. Specify the default accounts for activities, expense items, invoice items, and 
so on, and click Add to save these assignments. See MYOB Accounts for more. 
 

4.  Sending Data 
 
Now you are ready to sync data with MYOB. 
 

1. From the Integration menu in BillQuick, select MYOB, Send to MYOB.  
 
2. In turn, select each menu item, starting with Activity. After the progress bar indicates that the 

transfer is complete, open the corresponding screens in BillQuick and MYOB and verify the data 
is complete. See Quick-Check for more information. 
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Repeat this step for the next menu item. Below are the BillQuick Send menu items and the 
corresponding MYOB screen. 

BillQuick  
Send Menu Item 

MYOB 
Screen 

Activity* Activity 

Expenses* Items Bought** 

Employee* Card-Employee 

Vendor* Card-Supplier 

Client* Card-Customer 

Project* Jobs 

Time Entry Activity Slips 

Invoices Invoice 

Payments Receipts 

Purchase Orders Purchase Orders 

Chart of Accounts Chart of Accounts 

* The screen name may be different based on your profession or industry, or if you customized them 
using BillQuick Custom Label feature. 

** Items that are marked as ‘I sell this’ in MYOB, are marked as products in BillQuick. 
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5.  Fine Tuning Synchronization Settings 
 
After you check the data transferred to MYOB, you may want to change your integration settings to 
ones better suited for day-to-day synchronization. See Day-to-Day Integration Settings for more 
information. 
 
 

Scenario 2: New BillQuick-Existing MYOB User 
 
MYOB users who are new to BillQuick start by transferring data from MYOB to a new BillQuick company 
database. After creating the BillQuick database and setting synchronization preferences, you can initiate 
synchronization and check the transferred data  
 
Please follow the steps below to integrate BillQuick and MYOB: 
 
1.  Creating BillQuick Company 
 
Before integrating, a new BillQuick user must first create a BillQuick company database. See BillQuick 
Help and other documentation for more information. 
 

1. In BillQuick, select File menu, New. Choose the type of database technology you want to use. If 
unsure, choose Standard. 

 

 The database technology available to you depends on the BillQuick Edition 
purchased. If you are unsure what edition you licensed, select About BillQuick 
from the Help menu. The edition abbreviation displays right after the version 
number. 

 
 

Edition Database Technology 

BillQuick Basic Microsoft Access (Standard) 

BillQuick Pro Microsoft Access 
Microsoft SQL Express 

BillQuick Enterprise Microsoft Access 
Microsoft SQL Express 
Microsoft SQL Server 

 
2. On the New BillQuick Database dialog box, enter a name for the new database. Most commonly, 

the company name is used for easy identification. Click the Open button. BillQuick creates the 
database and opens the BillQuick Start-Up Interview wizard. 
 

 The BillQuick Start-Up Interview can be closed and reopened later. To do 
so, select BillQuick Interview from the View menu, Wizards. 

 
3. On the BillQuick Start-Up Interview page, click the Next button.  
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4. Leave Business Type blank. If you select a type, BillQuick copies industry-specific activity 

(service) and expense codes into your company database. These codes are not needed because 
items will transfer from MYOB into BillQuick. Click the Next button twice to bypass the Activity 
Codes page.  

 
5. Custom Labels allow you to change key business terms to suit your profession-specific and 

company-preferred terminology in BillQuick. Customizing terms eases transition from your old 
time and billing software. Select your preferred terms from the drop-down lists. When you have 
finished, click the Next button. 
 

6. On the Company Name page, enter your company name. Spell it exactly as it appears on the 
License and Registration or the Evaluation Key document or email that you received from BQE 
Software. 

 

 
 

7. Click the Next button to accept the defaults on the remainder of the pages. You can update 
these options later on the Global Settings and User Preferences screens. On the last page, click 
the Finish button. 
 

8. The BillQuick Initial Setup Checklist wizard opens. Because clients, jobs, and other data transfer 
from MYOB, you do not need to set up profiles. You can edit the data later. Close the wizard. 
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9. The Company page displays next. Either complete the data entry now and click the Save button 
when you have finished; or click the Close button and perform this task later. 

 
10. From the File menu, 

select Login. For User 
ID, type ‘supervisor’ 
(without quotes), 
then for password, 
type ‘supervisor’ 
(without quotes). This 
gives you security 
permissions in 
BillQuick to perform 
integration tasks.  

 
 
 
2.  Backing up Database 
 
Before the initial synchronization, it is important to back up your MYOB database. Select Backup option 
from the File menu. 
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3.  Specifying Synchronization Settings 
 
Specifying synchronization settings is necessary to define which data will be transferred as well as other 
preferences. Later, you can fine-tune the settings for day-to-day integration (see 5. Fine-Tune 
Synchronization Settings below).  
 

1. Look at the status line in the lower right of the BillQuick screen. It displays the BillQuick 
database that is open. If it is not the one you want to integrate with, select File menu, Open 
Company. Choose the correct company, and then continue to the next step. 
 

2. From the Integration menu, select MYOB, Sync Settings.  
 

3. Click the General tab. Under MYOB Settings, select the desired MYOB Data file (.myo) and MYOB 
Executable (Myobp.exe program file), which is available in the folder where you installed MYOB. 
This is required so that BillQuick can connect with the correct MYOB database for 
synchronization. 
 

4. Select the right ODBC Driver String from the drop-down. It is pre-selected if the ODBC Driver is 
installed automatically with the MYOB setup. This file makes a connection between BillQuick 
and MYOB possible.  
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5. Enter the User ID (default being Administrator) and Password (if any). Click Connect to load the 
company file and connect with the MYOB program. The location and path of the BillQuick 
Database integrating with MYOB is displayed at the bottom. 
 

6. Click the Get Settings tab. Select each Module on the left and assign settings to it. This will 
determine what data transfers from MYOB. See Get Settings for more information. 

 

 You can get Expense Items only if all the three options—I Buy This Item, I 
Sell This Item and I Inventory This Item—are selected in MYOB. 

 
4.  Getting Data 
 
Now you are ready to transfer data from MYOB to BillQuick.  
 

1. From the Integration menu in BillQuick, select MYOB, Get from MYOB.  
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2. In turn, select each menu item, starting with Activity. After the progress bar indicates transfer is 
complete, open the corresponding screens in BillQuick and MYOB to verify that the data is 
complete. See Quick Check section for more information. 
 

 
 

 Bill Rate and Cost Rate in BillQuick Employee records must be updated 
before syncing time records. In addition, special bill rates and cost rates 
associated with work done by employees on a project must be defined in a 
Service Fee Schedule and assigned to the project before syncing time records. 

 
3. Repeat this step for the next menu item. Below are the BillQuick Get menu items and the 

corresponding MYOB screen: 
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BillQuick  
Get Menu Item 

MYOB 
Screen 

Activity* Activity 

Expenses* Items Bought** 

Employee* Card-Employee 

Vendor* Card-Supplier 

Client* Card-Customer 

Project* Jobs 

Time Entry Activity Slips 

Invoices Invoice 

Payments Receipts 

Purchase Orders Purchase Orders 

Chart of Accounts Chart of Accounts 

* The screen name may be different based on your profession or industry, or if you 
customized them using BillQuick Custom Labels feature. 

** Items that are marked as ‘I sell this’ in MYOB, are marked as products in BillQuick. 

 
5.  Fine Tuning Synchronization Settings 
 
After you check the data transferred to BillQuick, you may want to change your integration settings to 
ones better suited for day-to-day synchronization. See Day-to-Day Integration Settings for more 
information. 
 
 

Scenario 3: Existing BillQuick-Existing MYOB User 
 
Typically, a company utilizes BillQuick to manage projects, enter time, generate invoices, record 
payments, and produce reports. MYOB is utilized for accounting tasks such as payroll, accounts payable, 
financial reports and so on. If you have been using both BillQuick and MYOB, and want the two 
programs to be able to share data, you need to develop a proper integration plan. This plan should take 
into consideration what data (if any) has been transferred between the programs in the past, either 
manually or via Import/Export facility. Based on this, your initial integration steps may vary. 
 
1.  Opening Database 
 
Since you have data in both BillQuick and MYOB, you need to open both programs. Ensure that the 
company databases that you want to sync are open. 
 
2.  Backing up Database 
 
Next, back up both BillQuick and MYOB databases. To back up the BillQuick Database, select BackUp 
Database from the Utilities menu. By default, BillQuick stores the backup copy in the same folder as the 
company database (for example, the standard installation folder x:\Program Files\BillQuick2015; x = 
drive letter). If you want the database copy to be saved in another location, select Global Settings-
Folders screen from the Settings menu and enter a new location. 
 
To back up your MYOB database, select Back Up option from the File menu. 
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In addition, in MYOB you need to assign permission to BillQuick to access its data (see Connection 
Instructions). You need to be logged in with administrative privileges to be able to do that. 
 
3.  Specifying Synchronization Settings 
 
Existing users have the option to send and get data according to their needs and business practice. What 
data is to be transferred depends on how you have been previously keeping your data in both programs. 
Some of the records being transferred between the two may already be present in the other database. 
In this case, the duplicates need to be merged.  
 

1. Open the BillQuick program. 
2. Look at the status line at the bottom of the BillQuick screen. It displays the BillQuick database 

that is open. If it is not the one you want to integrate with, select File menu, Open Company. 
Choose the correct company and then continue to the next step. 

3. Start MYOB and open the database that you want to integrate with BillQuick. 
4. From the BillQuick Integration menu, select MYOB, Sync Settings. The BillQuick-MYOB Sync 

Settings screen displays.  
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5. On the General tab, check the location of the MYOB Data file with which BillQuick is going to 
integrate.  
 

6. Determine what data you want to get from MYOB and what data to send. Accordingly, select the 
Send Settings and Get Settings tabs to access the synchronization settings. Select each Module 
on the left and assign settings to it. See Synchronization Settings for more information. 

 

 You should send approved time entries to MYOB only if you do payroll in 
MYOB. 

 

 It is preferable to create activity and expense (other charge) items in 
MYOB and have them transferred into BillQuick. This reduces the step of 
creating or assigning G/L accounts for them in BillQuick. See MYOB Accounts for 
more. 

 
7. For each data module, set your synchronization preferences. See Synchronization 

Settings for more. 
 

 If you have created Invoices and Payments in MYOB only, you should 
move the Clients, Projects, and Employees from BillQuick to MYOB. After these 
records are moved, you can then link the MYOB invoices and payments to 
these Projects. 

8. After the general settings for all the modules are specified, click the Account Assignment tab. 
Each BillQuick item has to be associated with a G/L account in MYOB. Specify the default 
accounts for activities, expense items, invoice items, and so on and click Add to save these 
assignments. See MYOB Accounts for more. 

 

 It is preferable to create activity and expense (other charge) items in 
MYOB and have them transferred into BillQuick. This reduces the step of 
creating or assigning G/L accounts for them in MYOB. 

 
9. Click on the Save button to save all the synchronization settings and then close. 

 
4.  Syncing Data 
 
Now you are ready to sync data between BillQuick and MYOB. 
 

 If you are trying to integrate a BillQuick Sample database with MYOB, you 
will be warned prior to syncing data. 

 
1. From the Integration menu in BillQuick, select an appropriate option-Send to MYOB or Get from 

MYOB.  
 

2. In turn, select each menu item, starting with Activity. After the progress bar indicates 
that the transfer is complete, open the corresponding screens in BillQuick and MYOB, 
and verify whether the data is complete. See Quick Check for more information. 
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Repeat this step for the next menu item. Below are the BillQuick MYOB Send and Get menu items 
and the corresponding MYOB screen. 
 

BillQuick  
Menu Item 

MYOB 
Screen 

Activity* Activity 

Expenses* Items Bought** 

Employee* Card-Employee 

Vendor* Card-Supplier 

Client* Card-Customer 

Project* Jobs 

Time Entry Activity Slips 

Invoices Invoice 

Payments Receipts 

Purchase Orders Purchase Orders 

Chart of Accounts Chart of Accounts 

* The screen name may be different based on your profession or industry, or 
if you customized them using BillQuick Custom Labels feature. 

 
 
 
 
5.  Matching Data  
 
In case of existing BillQuick and MYOB users, it is likely that duplicate records are found in the other 
program. This duplication arises because of separate entry of data in the two programs, even for similar 
records. The matching of these records can be a time consuming process. However, you will need to do 
it only once and then from that point onwards, data synchronization can be scheduled accordingly. To 
save time, you can skip matching of inactive records.  
 
During data synchronization, BillQuick will either overwrite the duplicate data or leave it as is, depending 
upon the Overwrite Rules specified in the BillQuick-MYOB Sync Settings screen. 
 
You can manually check and merge the duplicate data in any of the programs. The records that were 
moved from BillQuick to MYOB should stay and the MYOB records can be deleted after you have copied 
that data to the records created by BillQuick. The main reason for keeping the BillQuick-created records 
is that BillQuick maintains a link between the two programs after the first synchronization. This 
MYOBLinkID helps to update the two records in the future.  
 

Alternatively, you can make use of BillQuickMYOB Smart Match feature to link similar records or 
unlink different records in BillQuick and MYOB. You can view the matched and unmatched BillQuick and 
MYOB data on the Matched and Unmatched tab, respectively.  
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Depending upon the option selected in the Data field on the button panel, the relevant data will be 
displayed in the grids. UnLink or Link them accordingly using the respective buttons. See BillQuick Help, 

BillQuickMYOB Integration for more. 
 
6.  Fine Tuning Synchronization Settings 
 
Data touchup is needed in BillQuick after getting data from MYOB because BillQuick requires certain 
fields which may be optional in MYOB. After you check the data transferred to or from MYOB, you may 
want to change your settings to ones better suited to day-to-day synchronization. See Day-to-Day 
Integration Settings. 
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Quick-Check 
 
 
A standard procedure after initial syncing of data between BillQuick and MYOB is to check data. This 
ensures transferred data is accurate and complete. 
 

 BillQuick contains multiple processes to ensure accurate and complete 
transfer of data. However, MYOB settings and other factors may restrict 
transfer of data. Or you may have inadvertently checked filters on the Sync 
Settings screen.  

 
After syncing data, go to the section below for verification of data transferred.  
 
1.  Checking Activity and Expense Codes 
 
Detailed Checking 
 

1. In MYOB, select Activities from the Lists menu or Command Centres menu, Time Billing, 
Activities List. 

2. In BillQuick, select Activity Codes from the View menu. 
3. Switch between the programs, selecting the same activity item in both and checking 

that the data is same.  
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4. Repeat this for Expense Codes. In BillQuick, select Expense Codes from the View menu. 
In MYOB, select Lists menu, Items. Compare the records to the Items-Bought.  

 
Summary Checking 
 

1. In MYOB, select Reports menu, Index to Reports. From the Time Billing tab, select the 
Activities List report and then click on Display button. The report displays on the screen 
(if desired, you can print the report).  

 

 
 

2. In BillQuick, open the Activity Master File report from the Activity Codes screen. Else 
access it from the Reports menu, Activity.  

3. Compare the two lists to ensure all activities are transferred. 

4. Repeat steps 2 and 3 for Expense Codes. 
 
2.  Checking Employees 
 
Repeat the above process for employee data. Use the Detailed Checking or Summary Checking method. 
 
For detailed checking, in MYOB select Lists menu, Cards, Employee. In BillQuick, select Employees from 
the View menu. Compare the data in the two screens. 
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For summary checking, in MYOB select Reports menu, Index to Reports, Payroll. In BillQuick, select 
Employee Master File report from the Reports menu, Employee. Preview the reports and compare data. 
 

 Before entering time records or transferring time records from MYOB, 
review each employee record in BillQuick to make sure the Bill Rate and Cost 
Rate is correct. BillQuick uses these rates to calculate the bill amount and cost 
amount of time records. 

 
3.  Checking Vendors 
 
Repeat the above process. Use the Detailed Checking or Summary Checking method. 
 
For detailed checking, in MYOB select Lists menu, Cards, Supplier. In BillQuick, select Vendors from the 
View menu. Compare the data in the two screens. From BillQuick Vendor screen, determine which of 
the vendors transferred from MYOB (if any) should be deleted. Select the vendor from the grid, verify 
you selected the correct vendor and click the Delete button. 
 
For summary checking, in MYOB select Reports menu, Index to Reports, Purchases. In BillQuick, select 
the Vendor List report from the Report Center screen. Preview the reports and compare data. 
 

 If you enter time records for vendors (subcontractor, consultants) in 
BillQuick, be sure to change the Bill Rate and Cost Rate. When transferred from 
MYOB, BillQuick inserts $0 as placeholder value in vendor records.  
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4.  Checking Projects/Jobs 
 
Repeat the above process for projects. Use the Detailed Checking or Summary Checking method. 
 
For detailed checking, in MYOB select Lists menu, Jobs. In BillQuick, select Project Information from the 
Project menu. Compare the data in the two screens. 
 

 
 

For summary checking, in MYOB select a Job Slip report from the Reports menu, Index to Reports, Time 
Billing. In BillQuick, select the Project Master File report from the Reports menu, Project. Preview the 
reports and compare data. 
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Special Note 

BillQuick is project-centric. Each project is associated with a client. Time and expenses 
are charged to a project, and bills are generated by project (though multiple bills can 
appear on a joint invoice).  
 
In MYOB, you may have billed customers rather than jobs (projects). Or, you may have 
billed some jobs and some customers.  
 
BillQuick handles the situation automatically. It creates projects on the fly when you 
transfer customer invoices from MYOB. The Project ID is based on the Client ID from the 
invoice. If there is no ‘project name’ specified, BillQuick puts the ‘FromBQ-MYOBSync’ 
placeholder value in the Project Name field. This maintains data integrity in BillQuick. 
You can decide who is responsible for each project/job later. 
 
Bottom Line: You may need to repeat this quick-check step after syncing MYOB invoices 
to BillQuick. 

 
5.  Checking Time Entries 
 
Repeat the above process for time entries. Use the Detailed Checking or Summary Checking method. 
 
For detailed checking, in MYOB select the Command Centres menu, Time Billing, Enter Activity Slip. In 
BillQuick, select the Time-Expense menu, Enter Time, Sheet View. Compare the data in the two screens. 
 

 
 
For summary checking, in MYOB select the Activity Slip Detail report from the Reports menu, Index to 
Reports, Time Billing. In BillQuick, select any time report from the Report Center or Reports menu. 
Preview the reports and compare data. 
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6.  Checking Invoices  
 
Repeat the above process for invoices. Use the Detailed Checking or Summary Checking method.  
 
For detailed checking, in MYOB select Sales Register from the Command Centres menu, Sales. In 
BillQuick, select Billing menu, Review Invoices, Invoice Review. Compare the data in the two screens. 
 

 
 
For summary checking, in MYOB select a Sales report from the Reports menu, Index to Reports. In 
BillQuick, select any invoice or billing report from the Reports menu or Report Center. Preview the 
reports and compare data. 
 
7. Checking Payments 
 
Repeat the above process for payments. Use the Detailed Checking or Summary Checking method.  
 
For detailed checking, in MYOB select Sales Register (All Sales) from the Command Centres menu, Sales. 
In BillQuick, select Billing menu, Receive Payments, Payments. Compare the data in the two screens. 
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For summary checking, in MYOB select Cash Receipts Journal from the Reports menu, Index to Reports, 
Banking. In BillQuick, select Cash Receipts Detail report from the Reports menu, Payments or the Report 
Center. Preview the reports and compare data. 
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Day-to-Day Integration 
Settings 

 
 
After completing initial synchronization, review the settings to determine if they should be fine-tuned 
for day-to-day processes.  
 

It is a good practice to maintain clients, projects, time and expenses, billing, accounts receivables, 
payments and reports in BillQuick. MYOB should be used for functions such as accounts payable, general 
ledger, banking, payroll and financial statements. The following illustration gives an idea about the 
common breakdown of tasks you should be doing in BillQuick and MYOB. 

 

 
 

Below are situations to consider for each type of data and also the best practices followed in the 
industry. 

 

 Please check the Integration Rules for underlying rules and details about 

BillQuick MYOB Integration. 
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Master Information 
 
Consider where you want to save each type of master information – activity codes, expense codes, 
employees, clients, and projects. When you add, edit, or delete records, do you want this task done in 
BillQuick, in MYOB, or both? 
 
Commonly, companies maintain project records in BillQuick only. This is the core information essential 
to effective practice management and maintaining it in BillQuick is appropriate. Hence, it is better to 
create and maintain that data in BillQuick and send it to MYOB. 
 
However, it is a good practice to create activity and expense (other charge) items in MYOB because 
appropriate G/L accounts are assigned to them there. It is easier to transfer these items into BillQuick 
along with their G/L accounts. To enforce this policy, you should accordingly ‘turn on’ getting this data 

from MYOB. This can be done in the BillQuick MYOB Sync Settings screen by selecting the desired 
module and un-checking the ‘Do Not Get’ option. 
 
Where you maintain client (customer) records depends on your situation.  
 

Situation Synchronization Setting Action 

Require extensive customer 
information (for example, sales 
and payment defaults) 

From Send Settings list, select 
Client and check the ‘Do Not 
Send’ box. 

Maintain customer records in 
MYOB. Get updated records 
from MYOB as needed. 

Require typical customer 
information  

From the Get Settings list, select 
Client and check the ‘Do Not 
Get’ box 

Maintain client records in 
BillQuick. Send updated 
records to MYOB as needed. 

Desire convenience of update 
data common to BillQuick and 
MYOB, or want to enter data in 
either system 

From the Send Settings and Get 
Settings list, select Client and 
make sure both ‘Do Not…’ 
boxes are unchecked. 

Sync as needed. 

 
Decisions about employees follow a similar process.  
 
 

Time Records 
 
Whether you transfer time records from MYOB or not, time entries from employees (and 
vendors/suppliers) should be entered in BillQuick. It is designed for maximum data entry efficiency and 
maximum flexibility (4 built-in ways to manage time, plus 5 ways to capture your hours remotely). 
BillQuick also includes numerous time and expense, and work-in-progress reports. 
 
If you do payroll through MYOB, then you should transfer time data to MYOB. Make sure the ‘Do Not 
Send’ box for Time Entry is unchecked for Send Settings option in BillQuick-MYOB Sync Settings screen. 
BillQuick Time Entries become MYOB Activity Slips. 
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If payroll is not done through MYOB, then there is no reason to send time entries to it. Check the ‘Do 
Not Send’ option for time entries.  
 

 For payroll done using other programs, you can export time entries using 
BillQuick Import/Export feature (Utilities menu).  

 
Whether time entries flow to MYOB, depends on your situation. 
 

Situation Actions 

Use hours to 
process payroll 

Transfer time entries to MYOB. Block time entries flowing from 
MYOB into BillQuick.  

Do not use hours 
to process payroll 

Do not transfer time entries to MYOB. Block time entries flowing 
from MYOB into BillQuick. 

Use hours for 
special analysis 

Determine whether you analyze time (a) as a custom BillQuick 
report, (b) when exported to Excel, or (c) through MYOB. If (c) 
then follow the first suggestion above. 

 
However, there are some integration rules that limit the re-sending of the same time data to MYOB. For 
example, if you send a time entry to MYOB (say for 40 hours) and then change it in BillQuick, it cannot 
be re-sent as it creates duplicate hours. Even if you delete it in MYOB, it cannot be re-sent from BillQuick 
because it has already established a Link ID for it.  
 
You may send BillQuick time records by selecting ‘Send to MYOB’ option from the shortcut menu in the 
Sheet View screen. Then use the Reset Links option from the BillQuick-MYOB Sync Settings screen to 
undo the previous synchronization and send the updated time data. You can use this option for records 
that have already synced. 
 

 If you reset or ‘unlink’ the link, BillQuick will treat the record as new and 
add it to the MYOB database when you sync data next time. 

 
 

Invoices 
 
Creating invoices in BillQuick is the best course of action because it provides details critical to effective 
practice management. The most common synchronization scenario is to send invoices from BillQuick to 
MYOB. There can be an exception to this situation, for example, if you generate product invoices in 
MYOB and record payments for all invoices.  
 
Generally, invoices with zero value ($0) do not transfer from BillQuick to MYOB. You may generate zero 
dollar invoices in BillQuick in various ways: 
 

 You may manually adjust the New Bill value to $0 in the Billing Review screen. 

 You may generate a write-down on the invoice to $0 in the Time Entry or Billing Review screen. 

 You may generate a manual invoice with a $0 value in the Manual Invoice screen. 

 You may apply a huge discount to the bill amount, bringing down the Net Bill to $0 in the 
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Manual Invoice or Billing Review screen. 

 You may apply a retainer to the invoice, totally the Net Bill to $0 in the Manual Invoice or Billing 
Review screen. 

 
The only exception to transferring a zero dollar invoice is in case of retainers. You can send such invoices 
to MYOB in spite of having a $0 bill value. 
 
If you export invoice payments from BillQuick to MYOB involving credit (or write-offs) and regular 
payments, the payments are exported but excluding the credits (or write-offs). However, if you specify a 
Credit Income and Write-off Account in the importer, the credit payments are exported successfully. 
 

Late Fees 
 
At times, you may include a late fee or finance charge on your invoices. In such cases, you will receive a 
payment for the invoice amount plus that late fee amount. Earlier BillQuick transferred the invoice 
amount to MYOB but did not transfer the late fee or its payment. In order for the accounts receivable to 
match in the two databases (reconciliation of transactions), you had to manually create a finance charge 
and corresponding payment in MYOB. The finance charge had to be for the exact amount of late fees. 
 
However, BillQuick now allows you to transfer late fee charge to MYOB just as standard invoices. When 
you create a separate late fee invoice in Invoice Review screen, BillQuick generates a manual invoice 
internally with an invoice number same as that of the actual invoice but with ‘LF’ appended to it. The 
first late fee invoice will have the same invoice number but with a prefix of LF, and any subsequent late 
fee invoices will have initials LF1, LF2 and so on. After being created, you can transfer this manual late 
fee invoice to MYOB. You can also create a separate late fee payment for this invoice (excluding the 
principal amount) and then transfer it to MYOB. While transferring late fee invoices and payments, 
BillQuick will post them to the appropriate MYOB accounts.  
 

 You can specify invoice accounts in the BillQuick-MYOB Sync Settings 
screen.  

 

Payments 
 
You may decide to record payments for invoices and retainers in either BillQuick or MYOB. Or you may 
choose the convenience of entering payments in BillQuick. Mark the ‘Do Not Send’ and ‘Do Not Get’ 
options according to your preference. 
 

 In any case, you should make use of Date Filters in the Sync Settings 
screen to place less burden on the BillQuick and MYOB databases with 
unnecessary data transfer. 

 

 MYOB supports only on-demand synchronization. You need to manually 
get or send data using the BillQuick Integration menu to sync on a day-to-day 
basis. 
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Best Practices 
 

Items BillQuick MYOB 

Employees   

Vendors/Suppliers   

Activity/Service items   

Expense/Items Bought   

Clients/Customers   

Projects/Jobs   

Estimates/Budgets   

Service Fee Schedules   

Chart of Accounts   

Time/Activity Slips   

Vendor Bills   

Invoices   

Payments   

Payroll   

Billing   

Accounts Payable   

Accounts Receivable   

Reports   

Financial Statements   

Banking   

 
 

 
 
Congratulations! You have now an understanding of data integration between BillQuick and MYOB, how 
to ensure that the data transfer is accurate and how to verify which records have integrated. To learn 
more, check our trainings. 
 
For more information, visit us at www.bqe.com.If you have any trouble in using our integration tool, 
please contact BillQuick Support at (310) 602-4030 or Support@bqe.com. For other questions, please call 
us at (888) 245-5669 (US and Canada) or (310) 602-4020; or email Sales@bqe.com. 
 

http://www.bqe.com/Training.asp?pageId=Home
http://www.bqe.com/
mailto:Support@bqe.com
mailto:Sales@bqe.com
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